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This Quick Reference Guide is designed to help the user to familiarize themselves with the equip-
ment, perform basic hardware setup/communications and operation. For detailed information

on both Hardware & Software components, please refer to the Help system accessible in the
M.O.L.E.® MAP Software.

To access the help system start the software and use any of the methods listed:

¢ Select the Help Button on the Toolbar. @l
* Pressing the shortcut key [F1] l

¢ On the Help menu, click MAP Help. :




EQUIPMENT FEATURES/FUNCTIONS (3)

Activity Indicators:
Indicates state of the
M.O.L.E.® Thermal Profiler

Thermocouple/Inputs:
This is where Type “K” Thermo-
couple sensors are connected

OK Button:
Invokes “OK” process result-
ing in a GO-NO GO decision

ON/OFF Button:
Turns Profiler “ON/OFF”

Record Button:
Starts/Stops Profiler record-
ing data.

Charging LED: e—
Indicates when the internal
Power Pack is charging

RF Antenna Port:
This is where the Optional
RF antenna is connected

Data/Charging Port:
Transfers data to/from a com-
puter & charges the internal
Power Pack



Activity Indicat

Action

LED Col

Pack voltage is low

ON/OFF Indicates Profiler is “ON” and idle Green (Flashing)

Record Indicates Profiler is recording data Green (Flashing)

ok Indicates recorded profile passes Green- Pass (Solid)
pre-configured criteria Red- Fail (Solid) u
Indicates if internal temp is at or

|Te it Red (Solid) >40°C

SI{EERIG) above a threshold. ) .
Battery Indicates when the internal Power Red (Solid) <3.0v -

RF (Radio Frequency)

Indicates when unit and RF receiver is|
[transferring data

Blue (Flashing)

Pack is charging

Channel Indicators Indicates channel is configured or the |Green: Configured (Solid) L]
attached T/Cis open Red: Not config/Open (Solid) L]
Indicates when Profiler is connected
Rid G| Solid ]
aer o a RIDER® NL 2 test pallet eam elel
Charge Indicates when the internal Power ellow (Solid)

EQUIPMENT
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SETUP

Insert the USB computer interface cable

into a computer USB Port

Insert the other end into the Data/

Charging Port.

N

A completely discharged Power
Pack takes about 8 hours to be fully
charged. For quick charges, it can be
charged for 15 minutes allowing one
10 minute data run to be performed.

CHARGING THE POWER PACK (5)




1. Insert the Flash Drive in a USB Port and
the AutoPlay menu appears.

2. Select Open folder to view files but-
ton on the AutoPlay menu to launch rxs ECD M.O.LE® MAP (E)
Windows® Explorer. Closely follow the ~
instructions for your operating system.
For detailed information view the Instal-
lation Help file on the Flash Drive.

General options

QOpen folder to view file
J using Windows Exploreah

View more AutoPlay optiens in Control Panel

SETUP SOFTWARE INSTALLATION e




SETUP SOFTWARE INSTALLATION o

The user must have administrator
permissions for the computer to in-
stall and authorize the software. To

install as administrator, locate the
- . q a == (5.8
n setup.exe on the installation drive. i - S i
Right-click the file to display the e pe o
4 Drrarbhaddoti s & Fun e sdmerestings
shortcut menu and select Run as ad- R i bl oty &
s . s el e ma
ministrator. F s, e
e s i
Bt oabson s |
BT — 553
é-mm i
wner o




An Unlock Key can be obtained via an online
registration form or using the contact infor-
mation supplied on the dialog box, contact
ECD.

1. On the Help menu, click Register and the
dialog box appears.

2. Select Online Registration and enter the
required information on the M.O.L.E.®
MAP Software Registration form.

3. Enter the 16-digit Unlock Key and then
the Register command button to com-
plete the software Registration.

SETUP

MAP Registration

@

Online Registration...

Registration Number:

@ Unlock Key:

==

Manual Registration

Use the Registration Number
below to obtain your Unlock Key.

Web: www.ecd.com/register
Email: register@ecd.com
Phone: +1503 6596100

18978944

©)

[ Hep |

[ Ask Me Later ] Register

HORIZATION &



SETUP COMMUNICATIONS (9)

1. Plug the USB cable into a computer AutoPlay ==
COM Port and the other end into the
M.O.L.E.® Profiler Data Port. The Auto-
Play panel appears in the lower right cor-
ner of the desktop. This panel displays
the four most common MAP commands. General Options

Read Instrument. ..
2. Select Start M.O.L.E.® MAP ﬂ Download most recent recorded data run
AAl
B2 Start M.O.L.E.() MAP
@ Start using M.O.L.E.{r) MAP Software

(w7 Setup Instrument...

(@)@ SetaM.O.LE.(r) up to perform a data run

Instrument Status...
View the status of the M.O.L.E.(r)




® .

3. Onthe M.O.L.E.® menu, click the Select [ ]\01e0MP1300 C\Users\Document=\MOLE MAP\Basic Thermal o
Instrument Command, File Edit View Wizards [M.O.LE() | Machine-Oven Assembly-Board

EZZ3| [Ergmeer 3 SelctInstumen... ® aw m|E

4. Select the desired instrument from the
dialog box. If there are none displayed, Bz Fuking Instrument Status..
click the Scan for Instruments command
button to detect all available instru-
ments.

Setup Instrument...

[——
| Scan fon brstruments. |

OvenRIDER «
I

Once a M.O.L.E.® Profiler has been se-
lected, the software automatically selects
| that M.O.L.E. Profiler if it used again on

the same COM port.

5. Click the OK command button to accept.
G ) o | [ ]

SETUP COMMUNICATIONS &




OPERATION INTRODUCTION (1)

This operation procedure guides you through a typical process on how to set a M.O.L.E.® Ther-
mal Profiler up for performing a data run. For additional detail, consult the Help System in the
software.

The M.O.L.E.® Thermal Profiler depends on the MAP (Machine-Assembly-Process) software to
control how it collects and interprets data. Several kinds of data runs may need to be performed
to achieve desired information, or the same data run may be performed repeatedly over time to
monitor one process. Either way, each data run must be set up at least once.

The MAP software includes wizards that help you get started quickly, even if you are a beginner
or infrequent user.



STEP 1: SETUP INSTRUMENT

1.
2.

3.

Open the M.O.L.E.® MAP software.

Connect the M.O.L.E.® Thermal Profiler to the
computer.

Make sure the M.O.L.E.® Power Pack battery is fully
charged. When a M.O.L.E.® Thermal Profiler is se-
lected, the software status bar displays the current
battery voltage.

Set an Environment. Either open an existing Envi-
ronment Folder or create a new one.

OPERATION

®

M.O.LE(r) MAP V3.00  C:\Users\Documents\MOLE MAP\Basic Thermal Profiling Folder
File Edit View Wizards M.O.LE(r) Machine-Oven Assembly-Board Process-Paste Prof

EEBA| [Englneer -] w=|H|B|&| &|Q 21[lA#(m| 8|0 _|ﬂ|_‘

Basic Profiing
-

elect Environment Folder - Basic Profiling

C:\Users\Documents! asic
C:\ECD'MOLEMAP Sample \SampleBasic

OVENRIDER s

E
WaveRIDER..
Environment Folders
( e | [ o | | [rmermmin | o]
) A v
' AdlaliElLS s i
4 '\Wﬂlmms’.(m;(m)\l’mﬁh.( /
W) (422 8 [76F/24C =u@H [M.O.LE. Profiler [ Read Instrume

TUP INSTRUMENT ‘€



OPERATION SETUP INSTRUMENT (13)

When navigating through the wizard, | | A
the step list on the left of the dialog = (= ()= () mm"”“""“' ®
box uses a color key to inform the eyt B O et L o = N R |
user of the progression through the | ||a &iiimer | - e
. W Verfy Insnmert Stz
= wizard.
| 5
Hase

[Icurrent Crannel] 0] Uocwion Tioe ke
.Completed =

| Remaining Seasccs

[
i
i
@l
| 4]

5. Onthe M.O.L.E.® menu, select Setup Instrument
and the workflow wizard appears.

6. Setthe Instrument Name.



For settings such as Start Parame- | | e

ters and Stop Parameters, select | | @=@=@=p | e enes s
the More>> command button. ] O e D = it L (| =

T

7. Select the Sensor Platform button.

8. Select the desired sensors then the OK com-
mand button to proceed.

9. Confirm the settings and then, select the
Next command button to send the data listed in
the dialog box to the instrument.

OPERATION P INSTRUMENT @



OPERATION SETUP INSTRUMENT @

10. Confirm the assembly information such as the
test Product Description, size, sensor locations
and a image.

11. Click the Next command button.

elssisiz el

ron.. |
[ ] [scprevous] [memonp] [ 1o |[Comed ]
i

S



12. Verify the instrument status. This dialog box
displays the health of the M.O.L.E.® Profiler such as
battery charge, internal temperature, thermocou-
ple temperatures. [

If everything is OK, the dialog box dis-
plays a GREEN sign. If there are any
'E items that may prevent the user from
collecting good data, they are high-
lighted and a RED sign is displayed.

i
Hi.

i
|
;

13. Select the Finish command button to complete the
Setup Instrument wizard.

OPERATION UP INSTRUMENT ‘©



OPERATION DATA COLLECTION (17)

STEP 2: DATA COLLECTION

Never permit the M.O.L.E.® Thermal Pro-
filer to exceed the absolute maximum
warranteed internal temperature, as per-
manent damage may result. The warranty
x 3 will not cover damage caused by exceed-

ing the maximum specified internal tem-
perature.

1. Insert the Thermocouple sensors into the test
product. This process will vary depending on
the type of data you are trying to collect.

SOLDER TAPE TEMPROBE™



2. Connect the M.O.L.E.® Profiler to the sensors.
Press the M.O.L.E.® Profiler “ON” button.

4. Place the M.O.L.E.® Profiler in the appropri-
ate Thermal Barrier and press the “Record”
button.

w

5. Close the Thermal Barrier making sure the
sensor wires do not get pinched and the latch
is secure.

6. Pass the thermally protected M.O.L.E.® Profil-
er, and test product through the process.

When retrieving the M.O.L.E.® Profil-

| ‘: er and test product use caution as it
L may be warm.

OPERATION COLLECTION @




OPERATION DOWNLOAD DATA (19)

7. Asthe M.O.L.E.® and test product emerge from the
process, retrieve the sensors from the test product and
lay the Thermal Barrier on a table or flat surface.

8. Open the Thermal Barrier and if the Record button is
still flashing this means the M.O.L.E.® Profiler is still
logging and it should be stopped.

9. Remove the M.O.L.E.® Profiler from the Thermal Barri-

er and wait a few minutes for the M.O.L.E.® Profiler to
cool. Handle it carefully, as the case may still be warm.

10. Disconnect M.O.L.E.® Profiler from the sensors and
place it near the PC that has the MAP installed.

If sensors are removed before the M.O.L.E.®

.'E Profiler has stopped collecting data, it may
‘ cause the data to become distorted.




STEP 3: DOWNLOAD DATA

1. Connect the M.O.L.E.® Thermal Profiler to a AoPlay =
computer and the AutoPlay panel appears
in the lower right corner of the desktop. M.O.L.E m

2. Select the Read Instrument command and the \ottueref
workflow wizard appears. General Options

@E Read Instrument...

E= Download most recent recorded data run
BAE| Start M,0.LE. () MAP
Start using M.O.L.E.{r) MAP Software

w7 Setup Instrument...
(®)@ SetaM.0.LE () up to perform a data run

Instrument Status...
View the status of the M.O.L.E.{r)

OPERATION DOWNLOAD DATA 2




OPERATION DOWNLOAD DATA 1)

3. Select the desired data run from the M.O.L.E.®
memory list and then click the Finish com-
mand button to complete the wizard and mmmmm
read the data run from the M.O.L.E.® Profiler. d“g

If a data run (*XMG) is saved in a dif- | | s 7
ferent Environment Folder other than b bandi

the currently selected, the software
automatically activates the new Envi-
ronment Folder. This process does not
iE delete any data run files in the previ-
ously set Environment Folder and can
be quickly accessed using the Recent

Environment Folders on the File menu
or Welcome Worksheet.

ey Avdable: S

e <crew [ foios ] men | cned |




4. When the data run has been downloaded, the
software will prompt the user to name and
save the data run file (*.XMG).

[Esweowarin
. el - TGRS :
To prevent data loss, it is recom- pe——
mended that data run files (*.XMG) . ] =l
are not saved in the M.O.L.E. MAP B | B
'5 Sample Environments. Your Environ- e —
ment Folders should be in locations ‘f?:'gw mf:::"":,h.mﬂm_1
such as My Docs (Windows® XP) Li- & o Eﬂ.ﬁ'}‘m‘:ﬂm
braries>Documents (Winows® 7/8). AT B et iy
O i . :
5. The information is automatically saved in the ‘m::mwmw —— i"
data run file (*.XMG) and the experiment data e
can now be analyzed with the software tools. @

OPERATION DOWNLOAD DATA 2
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